Contents

1. Copyright Notice ........................................................................................................................................ 3
   1.1 Third party license information .................................................................................................................. 4

2. Introduction to PowerTrapper Standalone .................................................................................. 16
   2.1 What is Trapping? ................................................................................................................................ 16
   2.2 What is PowerTrapper Standalone? .......................................................................................................... 17

3. Trapping with PowerTrapper Standalone .................................................................................. 18
   3.1 The Trap Dialog ..................................................................................................................................... 19
      3.1.1 Distance and Direction Settings ........................................................................................................ 20
      3.1.2 Color and Shape Settings .................................................................................................................. 24
      3.1.3 Processing Settings .......................................................................................................................... 27
      3.1.4 Rules ................................................................................................................................................ 28
      3.1.5 Trap Presets .................................................................................................................................... 33
   3.2 The Trap Layer ...................................................................................................................................... 34
   3.3 The Trap Select Tool ............................................................................................................................. 34
   3.4 The Color Pairs Palette .......................................................................................................................... 34
      3.4.1 Viewing Traps .................................................................................................................................. 35
      3.4.2 Viewing Trap Settings ....................................................................................................................... 36
      3.4.3 Refining your Traps .......................................................................................................................... 36
      3.4.4 Trap Sessions ................................................................................................................................... 37
      3.4.5 Saving and Loading Color Pairs ......................................................................................................... 39

4. Selective Trapping ......................................................................................................................... 41

5. Add Rich Black ...................................................................................................................................... 42

6. PowerTrapper Preferences ............................................................................................................. 43
1. Copyright Notice

© Copyright 2017 Esko Software BVBA, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are the property of Esko Software BVBA. The material, information and instructions are provided on an AS IS basis without warranty of any kind. There are no warranties granted or extended by this document. Furthermore Esko Software BVBA does not warrant, guarantee or make any representations regarding the use, or the results of the use of the software or the information contained herein. Esko Software BVBA shall not be liable for any direct, indirect, consequential or incidental damages arising out of the use or inability to use the software or the information contained herein.

The information contained herein is subject to change without notice. Revisions may be issued from time to time to advise of such changes and/or additions.

No part of this document may be reproduced, stored in a data base or retrieval system, or published, in any form or in any way, electronically, mechanically, by print, photoprint, microfilm or any other means without prior written permission from Esko Software BVBA.

This document supersedes all previous dated versions.

PANTONE®, PantoneLIVE and other Pantone trademarks are the property of Pantone LLC. All other trademarks or registered trademarks are the property of their respective owners. Pantone is a wholly owned subsidiary of X-Rite, Incorporated. © Pantone LLC, 2015. All rights reserved.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyright © 1996-2002 The FreeType Project (www.freetype.org). All rights reserved.

Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk Media Entertainment.

Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.

Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP are Copyright ©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.

Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric Young (eay@cryptsoft.com). All rights reserved.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, Illustrator, InDesign, PDF, Photoshop, PostScript, XMP and the Powered by XMP logo are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.

Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the United States and other countries.

SolidWorks is a registered trademark of SolidWorks Corporation.

Portions of this software are owned by Spatial Corp. 1986 2003. All Rights Reserved.
JDF and the JDF logo are trademarks of the CIP4 Organisation. Copyright 2001 The International Cooperation for the Integration of Processes in Prepress, Press and Postpress (CIP4). All rights reserved.

The Esko software contains the RSA Data Security, Inc. MD5 Message-Digest Algorithm.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun Microsystems in the U.S. and other countries.

Part of this software uses technology by Best Color Technology (EFI). EFI and Bestcolor are registered trademarks of Electronics For Imaging GmbH in the U.S. Patent and Trademark Office.


Part of this software uses technology by Global Vision. ArtProof and ScanProof are registered trademarks of Global Vision Inc.

Part of this software uses technology by Qoppa Software. Copyright © 2002-Present. All Rights Reserved.

All other product names are trademarks or registered trademarks of their respective owners.

Correspondence regarding this publication should be forwarded to:

Esko Software BVBA
Kortrijksesteenweg 1095
B – 9051 Gent
info.eur@esko.com

1.1 Third party license information

This product includes Bonjour SDK.

Copyright (c) 2003-2004, Apple Computer, Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
3. Neither the name of Apple Computer, Inc. (“Apple”) nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY APPLE AND ITS CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL APPLE OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

--------------------------------------------------------------------------

This product includes Botan.

Copyright (C) 1999-2009 Jack Lloyd
2001 Peter J Jones
2004-2007 Justin Karneges
2005 Matthew Gregan
2005-2006 Matt Johnston
2006 Luca Piccarreta
2007 Yves Jerschow
2007-2008 FlexSecure GmbH
2007-2008 Technische Universität Darmstadt
2007-2008 Falko Strenzke
2007-2008 Martin Doering
2007 Manuel Hartl
2007 Christoph Ludwig
2007 Patrick Sona

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions, and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions, and the following disclaimer in the documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR(S) "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR(S) OR CONTRIBUTOR(S) BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

------------------------------------------------------------

This product includes ICC Profiles.

Some ICC Profiles were created by FFEI Ltd. (www.ffei.co.uk) using Fujifilm ColourKit Profiler Suite (www.colourprofiling.com)

------------------------------------------------------------

This product includes ICC Profiles.

Some ICC profiles are copyright (C) by European Color Initiative, www.eci.org

------------------------------------------------------------

This product includes ICC Profiles.

Some ICC profiles are copyright (C) of WAN-IFRA, www.wan-ifra.org

------------------------------------------------------------

This product includes ICC Profiles.

Some ICC profiles are copyright (C) IDEAlliance(R). G7(R), GRACol(R) and SWOP(R) are all registered trademarks of IDEAlliance(C).

------------------------------------------------------------

This product includes curl.

Copyright (c) 1996 - 2015, Daniel Stenberg, <daniel@haxx.se>. All rights reserved.

Permission to use, copy, modify, and distribute this software for any purpose with or without fee is hereby granted, provided that the above copyright notice and this permission notice appear in all copies.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN
NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Except as contained in this notice, the name of a copyright holder shall not be used in advertising or otherwise to promote the sale, use or other dealings in this Software without prior written authorization of the copyright holder.

This product includes LibTIFF.

Copyright (c) 1988-1997 Sam Leffler
Copyright (c) 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

This product includes FCollada.


Copyright (C) 1998-2003 Daniel Veillard. All Rights Reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

This product includes FreeType.

Portions of this software are copyright (C) 2014 The FreeType Project (www.freetype.org) licensed under the Freetype License. All rights reserved.

This product includes gSOAP.

EXHIBIT B.
Part of the software embedded in this product is gSOAP software.

Portions created by gSOAP are Copyright (C) 2001-2007 Robert A. van Engelen, Genivia inc. All Rights Reserved.

THE SOFTWARE IN THIS PRODUCT WAS IN PART PROVIDED BY GENIVIA INC AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

------------------------------------------------------------

This product includes ICU.

Copyright (c) 1995-2014 International Business Machines Corporation and others
All rights reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of
this software and associated documentation files (the "Software"), to deal in the
Software without restriction, including without limitation the rights to use,
copy, modify, merge, publish, distribute, and/or sell copies of the Software, and
to permit persons to whom the Software is furnished to do so, provided that the
above copyright notice(s) and this permission notice appear in all copies of the
Software and that both the above copyright notice(s) and this permission notice
appear in supporting documentation.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS NOTICE BE LIABLE FOR ANY CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL DAMAGES, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

------------------------------------------------------------

This product includes ilmbase.

Copyright (c) 2006, Industrial Light & Magic, a division of Lucasfilm Entertainment Company Ltd. Portions contributed and copyright held by others as indicated. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of Industrial Light & Magic nor the names of any other contributors to this software may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
This product includes iODBC.

Copyright (C) 1995-2006, OpenLink Software Inc and Ke Jin.
All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions
are met:

1. Redistributions of source code must retain the above copyright notice,
   this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright
   notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.
3. Neither the name of OpenLink Software Inc nor the names of its
   contributors may be used to endorse or promote products derived from
   this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL OPENLINK OR CONTRIBUTORS
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY,
OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE.

This product includes IP*Works!.

Copyright (c) 2013 /n software inc. - All rights reserved.

DISCLAIMER OF WARRANTY. THE LICENSED SOFTWARE IS PROVIDED "AS IS" WITHOUT
WARRANTY OF ANY KIND, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. FURTHER, /N SOFTWARE
SPECIFICALLY DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING
THE USE, OR THE RESULTS OF THE USE, OF THE LICENSED SOFTWARE OR DOCUMENTATION IN
TERMS OF CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE
ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE LICENSED SOFTWARE IS ASSUMED
BY YOU. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY /N SOFTWARE OR ITS
EMPLOYEES SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS
WARRANTY, AND YOU MAY NOT RELY ON ANY SUCH INFORMATION OR ADVICE. FURTHER, THE
LICENSED SOFTWARE IS NOT FAULT-TOLERANT AND IS NOT DESIGNED, MANUFACTURED OR
INTENDED FOR USE OR RESALE AS ON-LINE CONTROL EQUIPMENT IN HAZARDOUS ENVIRONMENTS
REQUIRING FAI-LSAFE PERFORMANCE, SUCH AS IN THE OPERATION OF NUCLEAR FACILITIES,
AIRCRAFT NAVIGATION OR COMMUNICATION SYSTEMS, AIR TRAFFIC CONTROL, DIRECT LIFE
SUPPORT MACHINES, OR WEAPONS SYSTEMS, IN WHICH THE FAILURE OF THE LICENSED SOFTWARE
COULD LEAD DIRECTLY TO DEATH, PERSONAL INJURY, OR SEVERE PHYSICAL OR ENVIRONMENTAL
DAMAGE ("HIGH RISK ACTIVITIES"). /N SOFTWARE AND ITS SUPPLIERS SPECIFICALLY DISCLAIM
ANY EXPRESS OR IMPLIED WARRANTY OF FITNESS FOR HIGH RISK ACTIVITIES.

LIMITATION ON LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, THE
LIABILITY OF /N SOFTWARE, IF ANY, FOR DAMAGES RELATING TO THE LICENSED SOFTWARE SHALL
BE LIMITED TO THE ACTUAL AMOUNTS PAID BY YOU FOR SUCH LICENSED SOFTWARE.
/N SOFTWARE'S LICENSORS AND THEIR SUPPLIERS SHALL HAVE NO LIABILITY TO YOU FOR ANY
DAMAGES SUFFERED BY YOU OR ANY THIRD PARTY AS A RESULT OF USING THE LICENSED SOFTWARE,
OR ANY PORTION THEREOF. NOTWITHSTANDING THE FOREGOING, IN NO EVENT SHALL /N SOFTWARE,
ITS LICENSORS, OR ANY OF THEIR RESPECTIVE SUPPLIERS BE LIABLE FOR ANY LOSS REVENUE,
PROFIT OR DATA, OR FOR INDIRECT, PUNITIVE, SPECIAL, INCIDENTAL OR CONSEQUENTIAL
DAMAGES
OF ANY CHARACTER, INCLUDING, WITHOUT LIMITATION, ANY COMMERCIAL DAMAGES OR LOSSES,
HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF THE USE OR
INABILITY TO USE THE LICENSED SOFTWARE, OR ANY PORTION THEREOF, EVEN IF /N SOFTWARE,
ITS LICENSORS AND/OR ANY OF THEIR RESPECTIVE SUPPLIERS HAVE BEEN INFORMED OF THE
POSSIBILITY OF SUCH DAMAGES. SOME STATES DO NOT ALLOW THE EXCLUSION OF INCIDENTAL OR
CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS MAY NOT APPLY. EACH EXCLUSION OF
LIMITATION IS INTENDED TO BE SEPARATE AND THEREFORE SEVERABLE.

This product includes IP*Works! SSH.

Copyright (c) 2013 /n software inc. - All rights reserved.

DISCLAIMER OF WARRANTY. THE LICENSED SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. FURTHER, /N SOFTWARE SPECIFICALLY DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE USE, OR THE RESULTS OF THE USE, OF THE LICENSED SOFTWARE OR DOCUMENTATION IN TERMS OF CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE LICENSED SOFTWARE IS ASSUMED BY YOU. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY /N SOFTWARE OR ITS EMPLOYEES SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY, AND YOU MAY NOT RELY ON ANY SUCH INFORMATION OR ADVICE. FURTHER, THE LICENSED SOFTWARE IS NOT FAULT-TOLERANT AND IS NOT DESIGNED, MANUFACTURED OR INTENDED FOR USE OR RESALE AS ON-LINE CONTROL EQUIPMENT IN HAZARDOUS ENVIRONMENTS REQUIRING FAIL-SAFE PERFORMANCE, SUCH AS IN THE OPERATION OF NUCLEAR FACILITIES, AIRCRAFT NAVIGATION OR COMMUNICATION SYSTEMS, AIR TRAFFIC CONTROL, DIRECT LIFE SUPPORT MACHINES, OR WEAPONS SYSTEMS, IN WHICH THE FAILURE OF THE LICENSED SOFTWARE COULD LEAD DIRECTLY TO DEATH, PERSONAL INJURY, OR SEVERE PHYSICAL OR ENVIRONMENTAL DAMAGE ("HIGH RISK ACTIVITIES"). /N SOFTWARE AND ITS SUPPLIERS SPECIFICALLY DISCLAIM ANY EXPRESS OR IMPLIED WARRANTY OF FITNESS FOR HIGH RISK ACTIVITIES.

LIMITATION ON LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, THE LIABILITY OF /N SOFTWARE, IF ANY, FOR DAMAGES RELATING TO THE LICENSED SOFTWARE SHALL BE LIMITED TO THE ACTUAL AMOUNTS PAID BY YOU FOR SUCH LICENSED SOFTWARE.
/N SOFTWARE'S LICENSORS AND THEIR SUPPLIERS SHALL HAVE NO LIABILITY TO YOU FOR ANY DAMAGES SUFFERED BY YOU OR ANY THIRD PARTY AS A RESULT OF USING THE LICENSED SOFTWARE, OR ANY PORTION THEREOF. NOTWITHSTANDING THE FOREGOING, IN NO EVENT SHALL /N SOFTWARE, ITS LICENSORS, OR ANY OF THEIR RESPECTIVE SUPPLIERS BE LIABLE FOR ANY LOST REVENUE, PROFIT OR DATA, OR FOR INDIRECT, PUNITIVE, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES OF ANY CHARACTER, INCLUDING, WITHOUT LIMITATION, ANY COMMERCIAL DAMAGES OR LOSSES, HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF THE USE OR INABILITY TO USE THE LICENSED SOFTWARE, OR ANY PORTION THEREOF, EVEN IF /N SOFTWARE, ITS LICENSORS AND/OR ANY OF THEIR RESPECTIVE SUPPLIERS HAVE BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES. SOME STATES DO NOT ALLOW THE EXCLUSION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS MAY NOT APPLY. EACH EXCLUSION OF LIMITATION IS INTENDED TO BE SEPARATE AND THEREFORE SEVERABLE.

This product includes IP*Works! SSL.

Copyright (c) 2013 /n software inc. - All rights reserved.

DISCLAIMER OF WARRANTY. THE LICENSED SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. FURTHER, /N SOFTWARE SPECIFICALLY DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE USE, OR THE RESULTS OF THE USE, OF THE LICENSED SOFTWARE OR DOCUMENTATION IN TERMS OF CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE LICENSED SOFTWARE IS ASSUMED BY YOU. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY /N SOFTWARE OR ITS EMPLOYEES SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY, AND YOU MAY NOT RELY ON ANY SUCH INFORMATION OR ADVICE. FURTHER, THE LICENSED SOFTWARE IS NOT FAULT-TOLERANT AND IS NOT DESIGNED, MANUFACTURED OR INTENDED FOR USE OR RESALE AS ON-LINE CONTROL EQUIPMENT IN HAZARDOUS ENVIRONMENTS REQUIRING FAIL-SAFE PERFORMANCE, SUCH AS IN THE OPERATION OF NUCLEAR FACILITIES, AIRCRAFT NAVIGATION OR COMMUNICATION SYSTEMS, AIR TRAFFIC CONTROL, DIRECT LIFE SUPPORT MACHINES, OR WEAPONS SYSTEMS, IN WHICH THE FAILURE OF THE LICENSED SOFTWARE COULD LEAD DIRECTLY TO DEATH, PERSONAL INJURY, OR SEVERE PHYSICAL OR ENVIRONMENTAL DAMAGE ("HIGH RISK ACTIVITIES"). /N SOFTWARE AND ITS SUPPLIERS SPECIFICALLY DISCLAIM ANY EXPRESS OR IMPLIED WARRANTY OF FITNESS FOR HIGH RISK ACTIVITIES.

LIMITATION ON LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, THE LIABILITY OF /N SOFTWARE, IF ANY, FOR DAMAGES RELATING TO THE LICENSED SOFTWARE SHALL BE LIMITED TO THE ACTUAL AMOUNTS PAID BY YOU FOR SUCH LICENSED SOFTWARE.
/N SOFTWARE'S LICENSORS AND THEIR SUPPLIERS SHALL HAVE NO LIABILITY TO YOU FOR ANY DAMAGES SUFFERED BY YOU OR ANY THIRD PARTY AS A RESULT OF USING THE LICENSED SOFTWARE, OR ANY PORTION THEREOF. NOTWITHSTANDING THE FOREGOING, IN NO EVENT SHALL /N SOFTWARE, ITS LICENSORS, OR ANY OF THEIR RESPECTIVE SUPPLIERS BE LIABLE FOR ANY LOST REVENUE, PROFIT OR DATA, OR FOR INDIRECT, PUNITIVE, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES OF ANY CHARACTER, INCLUDING, WITHOUT LIMITATION, ANY COMMERCIAL DAMAGES OR LOSSES, HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF THE USE OR INABILITY TO USE THE LICENSED SOFTWARE, OR ANY PORTION THEREOF, EVEN IF /N SOFTWARE,
THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

------------------------------------------------------------

This product includes openexr.

Copyright (c) 2006, Industrial Light & Magic, a division of Lucasfilm Entertainment Company Ltd. Portions contributed and copyright held by others as indicated. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of Industrial Light & Magic nor the names of any other contributors to this software may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

------------------------------------------------------------

This product includes OpenJPEG.

Copyright (c) 2002-2012, Communications and Remote Sensing Laboratory, Universite catholique de Louvain (UCL), Belgium
Copyright (c) 2002-2012, Professor Benoit Macq
Copyright (c) 2003-2012, Antonin Descampe
Copyright (c) 2003-2009, Francois-Olivier Devaux
Copyright (c) 2005, Herve Drolon, Freimage Team
Copyright (c) 2002-2003, Yannick Verschueren
Copyright (c) 2001-2003, David Janssens
Copyright (c) 2011-2012, Centre National d'Etudes Spatiales (CNES), France
Copyright (c) 2012, CS Systemes d'Information, France
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS 'AS IS' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
This product includes OpenSSL.

Copyright (c) 1998-2011 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following acknowledgment:
   "This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit. (http://www.openssl.org/)"

4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or promote products derived from this software without prior written permission. For written permission, please contact openssl-core@openssl.org.

5. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear in their names without prior written permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following acknowledgment:
   "This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/)"

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT AS IS AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

------------------------------------------------------------------

This product includes OpenSSL.

Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following acknowledgement:
   "This product includes cryptographic software written by Eric Young (eay@cryptsoft.com)"
The word 'cryptographic' can be left out if the routines from the library being used are not cryptographic related :-).

4. If you include any Windows specific code (or a derivative thereof) from the apps directory (application code) you must include an acknowledgement:

"This product includes software written by Tim Hudson (tjh@cryptsoft.com)"

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes PCRE.

Copyright (c) 1997-2016 University of Cambridge
All rights reserved.

Copyright(c) 2010-2016 Zoltan Herczeg
All rights reserved.

Copyright(c) 2009-2016 Zoltan Herczeg
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of the University of Cambridge nor the names of any contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes Qt.

The Qt Toolkit is Copyright (C) 2015 Digia Plc and/or its subsidiary(-ies).

The Qt Toolkit is Copyright (C) 2014 Digia Plc and/or its subsidiary(-ies).

This product includes QtMigration.

Copyright (C) 2013 Digia Plc and/or its subsidiary(-ies).

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of Digia Plc and its Subsidiary(-ies) nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

------------------------------------------------------------

This product includes XercesC.

NOTICE file corresponding to section 4(d) of the Apache License, Version 2.0, in this case for the Apache Xerces distribution.

This product includes software developed by
The Apache Software Foundation (http://www.apache.org/).

Portions of this software were originally based on the following:

------------------------------------------------------------

This product includes XMP Toolkit.

Copyright (c) 1999 - 2010, Adobe Systems Incorporated
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of Adobe Systems Incorporated, nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

------------------------------------------------------------

This product includes zlib.

Copyright (C) 1995-2004 Jean-loup Gailly and Mark Adler

This software is provided "as-is", without any express or implied warranty. In no event will the authors be held liable for any damages arising from the use of this software.
2. Introduction to PowerTrapper Standalone

2.1 What is Trapping?

The trapping process is a safeguard against possible (even likely) fluctuations in the printing process.

Minor discrepancies in registration, slight paper shifting or stretching of e.g. PE foil can cause inks to misregister. When two adjoining colored objects do not meet exactly, you can end up with a printed result like the one below:

![White Gap](image1)

The overlap creates a dark area and the gaps cause an undesirable light area. To prevent these potential discrepancies, a trap can be added, causing the original colors to slightly overlap each other:

![Trap](image2)

In general trapping is necessary when:

- The two colors each consist of at least one ink but they have no common inks.
- The two colors have one or more common inks, but the percentages of those common inks are significantly different in the two colors (for example a color made of 50% M and 10% C will be trapped with a color made of 50% Y and 80% C).

Placing a fine line where the colors join, made of a color that contains components of both adjoining colors, can trap such areas effectively.
2.2 What is PowerTrapper Standalone?

The PowerTrapper Standalone plug-in allows you to define trapping settings to automatically trap your documents in Illustrator.

You can:

• define common and advanced trapping settings (see The Trap Dialog on page 19),
• create specific trapping rules for trapping pairs of your choice (see Rules on page 28),
• save all your trapping settings as a preset to be able to reuse them on other documents (see Trap Presets on page 33),
• select your traps for further editing (see The Trap Select Tool on page 34),
• have a visual overview of the trapping settings by color pair, and refine them if necessary (see The Color Pairs Palette on page 34),
• remove your traps at any time as PowerTrapper Standalone trapping is non-destructive (your traps are created in a separate Trap Layer, see The Trap Layer on page 34).

Note:

• We recommend you use Illustrator’s Overprint Preview mode to see your traps more accurately.

• PowerTrapper Standalone doesn’t trap hidden objects. If you want to exclude an object from trapping, you can either hide it or use a rule.
3. Trapping with PowerTrapper Standalone

To introduce you to PowerTrapper, here is how to add simple traps to a document.

1. Open the document you want to trap.
2. Go to Window > Esko > PowerTrapper > Trap ... or use the Option + Shift + Command + X shortcut (on Mac).
3. In the Trap dialog that opens, enter the Trapping Distance you want to use.

![PowerTrapper interface with options for Trapping Distance and Color & Shape settings]

4. Go to the Color & Shape tab and choose:
   - how to Truncate Traps (on center or on edge),
   - how to shape the End Caps (square, round or object dependent),
   - how to shape the Trap Corners (round, beveled or mitered).
3. PowerTrapper for Adobe Illustrator

![PowerTrapper Dialog](Image)

**Note:**
For more information about the different trapping settings you can choose, see:

- *Distance and Direction Settings* on page 20,
- *Color and Shape Settings* on page 24,
- *Processing Settings* on page 27.

5. Click the **Trap** button to trap your document. This creates your traps in a new Trap Layer.

**Note:**
- To cancel the trapping process, use the **Escape** key.
- To undo your traps once trapping is done, use **Command + Z**.

### 3.1 The Trap Dialog

The **Trap** dialog is where you define all your trapping settings.

1. Go to **Window > Esko > Trapping > Trap ...**, use the **Option + Shift + Command + X** shortcut (on Mac) or double-click the Trap Select tool to open the Trap dialog.
2. Choose your trapping settings in the Distance & Direction, Color & Shape, and Processing tabs.

3. If needed, define trapping rules.

4. Save your trapping settings as a trap preset to be able to reuse them on another document.

Note: The Trap Preset List contains 6 default presets.

### 3.1.1 Distance and Direction Settings

**Trapping**

You can choose between two trapping modes:

- **Normal Trapping**: This selects adjoining color pairs, which are likely to cause registration problems like ugly light gaps, and unwanted halo effects.

  PowerTrapper Standalone automatically chooses the most appropriate trap direction based on the relative luminance of the adjoining colors. Lighter colors are generally trapped into darker colors to minimize the visual effect of the trap.

- **Reverse Trapping**: This prevents overprint of adjoining color areas by trapping these color pairs with a white knockout (erasing) trap. The white knockout trap is put on top of the lighter of the two colors.

  This is useful to prepare a job for Dry Offset printing (e.g. metal beverage cans) where overprinting of inks is not allowed as the inks would contaminate each other on the blanket.

**Trapping Distance**

Enter the width you want to give your traps. The unit used is the General unit defined in Illustrator’s Unit & Display Performance Preferences.

The default trap width is 0.2 mm (or equivalent in your chosen unit).

**Minimum Ink Difference**
PowerTrapper for Adobe Illustrator

Trapping is applied to two adjoining colors when either:

• The two colors each consist of at least one ink but they have no common inks.
• The two colors have common inks but there is a difference of at least the **Minimum Ink Difference** percentage for two or more inks making up these colors.

These differences in ink percentages must be in opposite directions.

For example, with the default minimum ink difference percentage of 10%, the following two colors will be trapped:

1st color: C 5% M 10% Y 50% K 15% (+10% K)
2nd color: C 5% M 10% Y 85% K 5% (+35% Y)

Increase the minimum ink difference to trap colors that are more different, lower it to trap colors that are more similar.

**Image Trapping**

• **Automatic** (default): this determines the most suitable trap direction automatically, by comparing the average lightness of the CT image with the lightness of the adjoining area, then traps the lighter color into the darker one.
• **Always Towards Images**: this always traps line art under adjoining CT images.
• **Always Towards Line Art**: this always traps CT images under adjoining line art.

**Pull Back**

An ink pull back keeps away all but the darkest ink of a color area composed of multiple inks that borders to a very light background.

It prevents individual inks from the composed color to become visible on the background due to registration errors during the printing process.

Ink pull back is also known as “Cutbacks” or “Keepaways”.

The example below shows an object with 100% dark blue and 50% magenta on an empty background. 50% magenta is pulled back and a fine line of 100% dark blue remains. The color that remains (dark blue) is the **pull back ink**.
• **Automatic** (default): this creates pull backs on rich black or rich colors, when the color left in the pull back area is not very different from the composed color.

In the example below, the left color is composed of 100% purple ink and 20% cyan. The darkest ink (purple) is not very different from the composed color, so using the **Automatic** pull back option will create a pull back.

The right color is composed of 100% dark red ink and 20% blue ink. The darkest ink (dark red) is very different from the composed color, so using the **Automatic** pull back option will **not** create a pull back.

• **Only Pull Back Rich Black**: this only creates pull backs on rich black.

• **Do Not Pull Back**: this never creates any pull back.

**Advanced Settings**
Click the triangle beside **Advanced Settings** to show the advanced settings.

**Trapping Distance**
If you want to use a different distance when trapping into black, spot colors or images or when creating pull backs, enable the corresponding option and enter the trapping distance to use.

The unit used is the **General** unit defined in Illustrator's **Unit & Display Performance Preferences**.

**Image Trapping**
If you don't want images to be trapped with each other, disable **Trap images to images**.

**Pull Back**
If you chose to use **Automatic** pull back (see **Pull Back**), the **Also pull back light inks** option is available. Enable it if you want to create pull backs even when the pullback ink (ink remaining in the pull back area) is visibly different from the composed color.

Enable **Pull back images and gradients** if you want to create pull backs on images and gradients.

**Trap decision**
• By default, PowerTrapper uses the color luminance (**Use Lightness**) to define the trapping direction, except for opaque inks, for which the Inks order is used.

• trap direction: from brightest to darkest
• If the **Treat spot colors as opaque** option is chosen, color luminance is used only for CMYK. For opaque and spot inks, the trap direction is determined by the ink sequence.
  • trap direction for spot colors only: towards the separation listed the lowest in the Separations palette darkest
  • trap direction goes from the process to the spot color if the spot color is below the process color in the Separations list
  • trap direction if the spot color is above the process color: from brightest to darkest
• **By selecting Use separation order**, the trap direction is determined by the ink sequence for all inks, including CMYK.
  • trap direction: towards the separation listed the lowest in the Separations palette darkest
• **Use reverse separation order** does the same, using the reversed ink sequence.
  • trap direction: towards the separation listed the highest in the Separations palette darkest

**Note:** Using the Separation Order option will give the same result as changing all inks (including CMYK) to Opaque.

**Overshoot Mode**

You can choose between the following three overshoot modes:

• **Automatic** (default): The centerline behavior is according the rules determined in the color pair list.
• **Never on Dark Areas**: The centerline is forced not to get beyond the center of dark areas.
• **Never**: The centerline is forced not to get beyond the center of any area.

An example:

![Image of color pairs](image)

During trapping, this example will generate the following color pairs:

![Color Pair List](image)

By default (**Automatic**), this color pair list results in the following traps:
If the parameter is set to **Never on Dark Areas**, this will result into:

If the parameter is set to **Never**, this will result into:

### 3.1.2 Color and Shape Settings

**Trap Color Intensity**

By default, PowerTrapper uses the full color of the object to spread in the trap (100% trap color intensity).

However, you can create a trap of a lighter color by reducing the trap color intensity percentage.

**Image Trap Color**

Choose how to trap your images:

1. **Use Original Image Data** (default): when spreading an image, PowerTrapper uses the underlying image data (when the image is clipped) to create the trap (see example 1 below).
Note: When there is no underlying image data (the image isn't clipped), it will create an empty trap.

2. **Extend Image Data:** PowerTrapper will automatically extrapolate the image along its clipping path edge to ensure the trap looks as expected even if there is no clipped image data outside the visible image (see example 2 below).

3. **Use an Approximate Flat Color:** Instead of using existing or extrapolated image data in the trap, PowerTrapper will use a solid color. A suitable color is determined by averaging the image's colors along its boundary with the object to trap (see example 3 below).

![Examples](image)

Note: If the **Use Postscript Compatible Image Traps** preference is on, the image trap color option has no influence on the result. Trapping will not generate any extra image data but image traps will create traps with lineart representing vectorized pixels. The lineart will also use Postscript Overprints instead of the multiply blend mode. These image traps are always created using the 'Use Original Data' option. Note that to have a correct visualization of your traps, you need to switch on the 'Overprint Preview' in the Illustrator View menu.

Note: **Convert Blended Objects to Images** in the PowerTrapper Preferences will convert blended objects to images before trapping.

### Truncate Traps

PowerTrapper can truncate the trap so that it doesn't stick out on another color. There are two truncation modes:

- **On Center** (default): when a portion of a trap comes too close to the contour of another object, PowerTrapper Standalone limits it to half the distance between the trapped object and the other object.

- **On Edge**: when a portion of a trap comes too close to the contour of another object, it is truncated on the other object's edge.

![Truncation Examples](image)
End Caps
This option specifies how to shape the ends of an open trap.

- **Square** ![Square](image) (default): this option ends the trap at right angle to the adjoining object.
- **Round** ![Round](image): this rounds the ends of the trap. This option is typically only used in combination with white knockout (reverse trapping).

**Attention:**
We recommend not to use **Round End Caps** together with **Truncate Traps On Center**, as this can generate some artefacts (the round caps will be truncated).

- **Object Dependent** ![Object Dependent](image): with this option, the trap is a logical continuation of the contour of the spread object.

Trap Corners
This option allows you to change how the traps’ sharp corners will be handled.

- **Round** ![Round](image) (default): a round cap will be placed at all corners.
- **Beveled** ![Beveled](image): this will cut sharp corners off.
- **Mitered** ![Mitered](image): this option works with a miter ratio.

The miter ratio serves to limit the length of the sharp corner (the distance from the base of the trap to the corner point).
The default miter ratio value is 4. This means that if the length of the sharp corner is more than 4 times the **Trapping Distance**, then the corner will be cut off (beveled). If it is less than 4 times the **Trapping Distance**, the corner will be left as it is.

**Advanced Settings**

Click the triangle beside **Advanced Settings** to show the advanced settings.

**Truncate Traps**

If you want to truncate traps into black differently, select **Into black** and choose the truncation mode (**On Center** or **On Edge**). For more information about truncation modes, see **Truncate Traps**.

### 3.1.3 Processing Settings

**Color Pairs**

PowerTrapper can trap all hits (occurrences) of a color pair the same way, or recalculate the trap direction for different hits.

- **Each hit can have its own decision** (default): this recalculates the trap direction for each hit of a color pair.
- **Same decision for all hits**: this traps all hits of the same color pair in the same direction.
- **Same decision for objects smaller than**: this uses the same trap direction for hits of a color pair belonging to small objects, and recalculates the trap direction for hits belonging to bigger objects.

Use the field next to the option to determine the maximum size of small objects.

The unit used is the **General** unit defined in Illustrator's **Unit & Display Performance Preferences**.

The default size is 1 mm (or equivalent in your chosen unit).

**Restrictions**

In some cases PowerTrapper can safely ignore certain object types to speed up the trapping.
• **Respect existing traps**: if your document has already been trapped, select this option to keep the existing trap layer out of the trapping process.

• **Ignore bitmaps**: this keeps bitmap pixel data from being trapped. Bitmap data is contourized before trapping, which may slow down trapping depending on the bitmap’s contents. Bitmaps with lots of small isolated islands will typically take a longer time to trap.

  **Attention**: When you indicate an object type to ignore, it will be ignored completely as if it did not exist in the job. Also, the ignored objects will not truncate trapping areas resulting from other objects below them.

If the **Respect existing traps** is enabled, traps in the selection will be kept, and no trapping is performed on these locations. If the option is off, selected traps will be removed, and will be re-trapped. This only works for traps created by PowerTrapper or Instant Trapper.

**Small Gaps**

Some input jobs contain very small unintentional gaps between neighboring objects, preventing the correct trapping of these objects. Although it is better to clean up such jobs before trapping, PowerTrapper can ignore these gaps automatically.

To use this option, select **Close when smaller than** and enter the maximum size small gaps can have.

The unit used is the **General** unit defined in Illustrator’s **Unit & Display Performance Preferences**.

The default size is 0.01 mm (or equivalent in your chosen unit).

  **Attention**: If you set a big gap size, trapping may become slower, and small parts of the job may be ignored during trapping.

### 3.1.4 Rules

Rules allow you to define custom trapping settings for specific trapping pairs.

**When to Use Rules?**

In most cases the general trapping settings you enter in the **Trap** dialog will give you excellent results, but in some cases you will need to refine them using rules.

Rules allow you to specify exceptions to the general trapping settings for certain color pairs. They are an advanced feature and should be used only by experienced users.

For example, you can use them in the cases below:

• To set a different trap distance for a specific spot ink.
  
  Sometimes you need a larger trap distance for spot inks if there is no other ink to help cover leaks on the press.

• To prevent trapping or ink pull back in specific cases.
  
  Depending on the type of the adjoining colors, trapping and / or pull back may be undesirable.

• To force a specific trap direction.
PowerTrapper for Adobe Illustrator

PowerTrapper determines the trap direction based on the relative lightness of the adjoining colors. If the colors have a similar lightness level, it selects an arbitrary direction. You can use a rule to make it always use a particular direction for a color pair.

- To specify a different shape and/or truncation mode for certain color pairs.
  For example you can choose to use “On Center” truncation when trapping under a 100% black line and “On Edge” truncation on all other color pairs.

Creating a Rule

1. Click the **Add Rule** button at the bottom of the **Trap** dialog.

![Specify Rule dialog](image)

2. In the pop-up that opens, choose the trapping pair to apply the rule to using the **From** and **To** lists.
   You can create a rule to trap from/to:
   - any color,
   - a particular ink (process, spot or opaque),
Note:
In this case, you can choose the ink name, from which **Minimum Density** the rule will apply, and if the color must be pure (no other separation in the color object) to apply the rule.

![Image with dropdown menu]

If **Spot Ink** is selected, the dropdown underneath will contain all Spot Colors used in the document.

- A specific Printing Method
- A particular object (image, gradient or empty background),
- The registration color.

3. Choose the contents of the rule.

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trap</td>
<td>• <strong>Automatic</strong> lets PowerTrapper calculate the trapping direction.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Always Trap</strong> always spreads the “From” color/object on the “To” color/object.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Do Not Trap</strong> never traps the “From” and “To” colors/objects together.</td>
</tr>
<tr>
<td>Trapping Distance</td>
<td>Use this to define a special trapping distance for the trapping pair.</td>
</tr>
<tr>
<td>Trap Color Intensity</td>
<td>Use this to define a special trap color intensity for the trapping pair.</td>
</tr>
<tr>
<td>Pull Back</td>
<td>• <strong>Automatic</strong> lets PowerTrapper decide if there should be a pull back on the trapping pair.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Always Pull Back</strong> always creates a pull back on the trapping pair. The darkest ink of the pair is the pullback ink (remaining ink in the pull back area).</td>
</tr>
<tr>
<td>Options</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Do Not Pull Back</td>
<td>always creates a pull back on the trapping pair.</td>
</tr>
<tr>
<td>Pull Back Distance</td>
<td>Use this to define a special pull back distance for the trapping pair.</td>
</tr>
<tr>
<td>Pull Back Fill Mode</td>
<td>Normal gives normal pull backs. Sharpen allows sharpening on pull backs. This sharpening is used e.g. for white text on images, on CD's or DVD's. Sharpening is done by pulling back the image, and adding 100% black in the trapping area.</td>
</tr>
<tr>
<td>Reverse</td>
<td>Automatic lets PowerTrapper decide if the trapping pair should have a reversed trap.</td>
</tr>
<tr>
<td></td>
<td>Always Trap Reversed always generates a reversed trap for the trapping pair.</td>
</tr>
<tr>
<td></td>
<td>Do Not Trap Reversed never generates a reversed trap for the trapping pair.</td>
</tr>
<tr>
<td>Truncate Traps</td>
<td>Choose if traps generated for the trapping pair should be truncated on center or on edge. See Truncate Traps for details.</td>
</tr>
<tr>
<td>End Caps</td>
<td>Choose how to shape the ends of open traps for the trapping pair (square, round or object dependent). See End Caps for details.</td>
</tr>
<tr>
<td>Trap Corners</td>
<td>Choose how to shape the trapping pair's trap corners (round, beveled or mitered). See Trap Corners for details.</td>
</tr>
<tr>
<td>Direction Mode</td>
<td>Select into both colors to use bidirectional trapping. In case of bidirectional trapping, the trap will go half the trapping distance in each direction.</td>
</tr>
<tr>
<td>Horizontal / Vertical distortion</td>
<td>Set the percentage of the trapping distance to be used in vertical / horizontal direction. In the example underneath, the trap was generated with no vertical distortion (so 100%, i.e. using the entered trap distance) and horizontal distortion set to 50% (i.e. half the trap distance).</td>
</tr>
</tbody>
</table>
4. If necessary, use the button to add contents to your rule.

![Rule Specifier](image)

You can use the button to remove contents.

5. When you are done defining your rule, click OK.

You can now see your rule at the bottom of the Trap dialog.

![Rule Display](image)

When trapping your document, PowerTrapper will trap the trapping pairs that match rules according to those rules, and the rest of your document according to the main trapping settings.
If necessary, you can add another rule, or remove a rule previously created. You can also edit a rule by double-clicking it in the Trap dialog.

### 3.1.5 Trap Presets

With PowerTrapper, you can save all your trapping settings as a preset to be able to reuse them on other documents.

Trap Presets can be shared between different Esko Applications (PackEdge, ArtPro, DeskPack, ...)

The Trap Presets list contains 6 default Presets that can't be changed or removed:
- Default
- Bi-directional (including a rule to trap into both colors)
- Combipress (including a rule based on Printing Method)
- Offset (optimized for offset printing)
- Reverse
- Sharpening (including a rule optimized for sharpening)

#### Defining a Trap Preset

1. Define your trapping settings in the Trap dialog. Add rules if you need to.
   - See Distance and Direction Settings on page 20, Color and Shape Settings on page 24, Processing Settings on page 27 and Rules on page 28.
2. In the Trap Preset list, choose Save...
3. Give your preset a name and click OK.

You can now see your preset in the Trap Preset list. To reuse it in the future, just select it in the list.

- To delete a preset, select it in the Trap Preset list then select Remove.
- To edit a preset, select it in the Trap Preset list, make your changes in the trapping settings, then save it again with the same name.
- The location where the Trap Presets are saved, is set in Illustrator > Preferences > Esko > PowerTrapper Preferences ...

When choosing Use Shared Trap Ticket Folder, Trap Presets are saved in the default “shared users” folder:
- /Users/Shared/EskoArtwork/Trap Tickets on Mac OS X
- C:\Documents And Settings\All Users\Documents\EskoArtwork\Trap Tickets on Windows XP
- C:\Users\Public\Documents\EskoArtwork\Trap Tickets on Windows 7

When choosing Use Custom Trap Ticket Folder, Trap Presets are saved in the folder you define by clicking the Browse button.

Note: Because PowerTrapper in earlier versions (before 10.1) used a different default location, upgrading to 10.1 or higher will try to set the Preference to Use Custom Trap Ticket Folder, pointing to the previous Default folder, so you can keep using your Trap Tickets.
3.2 The Trap Layer

PowerTrapper creates traps in your document’s Trap Layer, and leaves the other layers intact. If your document doesn't contain a trap layer, PowerTrapper will create one.

![Layers panel with Trap Layer selected]

3.3 The Trap Select Tool

You can find the Trap Select tool in the Tools panel. Use it to select trap areas in your job, or double-click it to open the Trapping dialog.

You can:

- click between two adjoining color areas to highlight the edge and select the trap,
- make a rectangle selection to highlight all edges and select all traps in that rectangle.

**Note:** Selecting one or more traps in your document using the Trap Select Tool also selects the corresponding color pair(s) in the Color Pairs palette. See *The Color Pairs Palette* on page 34.

**Tip:** Sometimes the highlight color doesn't contrast enough with your document’s colors to be easily visible. In this case you should modify the Trap Layer’s highlight color.

3.4 The Color Pairs Palette

After trapping your document, the Color Pairs palette shows the trapping settings associated with each of your document’s color pairs.

It pops up automatically after trapping, or you can go to **Window > Esko > Trapping > Color Pairs** to open it.
For each color pair, the palette shows:

- the number of **Hits** (occurences of that color pair) in the document,
- the type of object in the pair (empty background 🔄, flat color 🟢, image 📸 or gradient 🌉),
- the type of trap performed on that color pair (normal trap 🌡, pullback 🔴, reverse trap 🔴),
- the trapping **Distance** used,
- the traps’ **Shape** (truncation 🌴, caps 🌴, corners 🌴),
- the **Intensity** of the trap color,
- the **Pullback Ink** (when the trap is a pullback).

### 3.4.1 Viewing Traps

- To select all the traps of a color pair in your document, click that color pair in the **Color Pairs** palette.

**Note:** Use **Command** or **Shift** to select several color pairs, and highlight all the corresponding traps in your document.

- To select traps without showing the highlight color around them, click 🌟 or select **Don’t Highlight Selected Edges** in the palette’s fly-out menu.

To show the highlight color around selected traps again, click 🌟 again or select **Highlight Selected Edges** in the menu.

- To zoom on selected traps, click 🔍 or select **Zoom to Selected Edges** in the menu.

To revert to the previous zoom, click 🔍 again or select **Don’t Zoom to Selected Edges** in the menu.

- If the **Trap Select** tool is active, use the arrow keys to browse through the color pairs. Activate the **Zoom to Selected Edges** to browse and visualize your traps one by one in your job.
3.4.2 Viewing Trap Settings

You can hide trapping settings that you are not using to make the **Color Pairs** palette smaller.

- To hide all color pairs that are not trapped with each other, select **Hide Non-trapping Color Pairs** in the palette’s fly-out menu.
  
  To show them again, select **Show All Color Pairs** in the fly-out menu.

- To hide all color pairs that don’t have traps selected in your document, click or choose **Hide Unselected Edges** in the palette's fly-out menu.
  
  To show them again, click again or select **Show All Edges** in the menu.

- To hide the **Distance**, **Shape**, **Intensity** or **Pullback Ink** column, select **Hide Distance/Shape/Intensity/Pullback Ink Column** in the palette’s fly-out menu.
  
  To show the column again, select **Show Distance/Shape/Intensity/Pullback Ink Column** in the fly-out menu.

3.4.3 Refining your Traps

You can use the **Color Pairs** palette to select certain traps and change their trapping settings.

1. Select either:
   
   - the color pair(s) to edit in the palette,
   - the traps to edit in your document (if you want to only edit certain traps of a color pair).

2. Make your desired changes as explained below:

<table>
<thead>
<tr>
<th>to change a color pair’s...</th>
<th>do...</th>
</tr>
</thead>
<tbody>
<tr>
<td>trapping direction</td>
<td>click Swap Trap Direction [ ] Trap direction can be from left to right, from right to left, or bidirectional. In case of bidirectional trapping, the trap will go half the trapping distance in each direction.</td>
</tr>
<tr>
<td>to change a color pair's...</td>
<td>do...</td>
</tr>
<tr>
<td>--------------------------</td>
<td>------</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td></td>
</tr>
<tr>
<td>When you change the direction for only certain traps of the color pair, the color pair will be duplicated in the palette (e.g. one entry for spread and one for choke).</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>trap type</th>
<th>choose Normal Trap 🌡️, Pullback 🌡️ or Reverse Trap 🌡️ in the Trap column. You can also use this to trap a non-trapping color pair.</th>
</tr>
</thead>
<tbody>
<tr>
<td>trap distance</td>
<td>click the Distance value to edit it.</td>
</tr>
<tr>
<td>trap truncation</td>
<td>choose On Center 🌡️ or On Edge 🌡️ in the Shape column.</td>
</tr>
<tr>
<td>end caps</td>
<td>choose Square 🌡️, Round 🌡️ or Object Dependent 🌡️ in the Shape column.</td>
</tr>
<tr>
<td>trap corners</td>
<td>choose Round 🌡️, Beveled 🌡️ or Mitered 🌡️ in the Shape column.</td>
</tr>
<tr>
<td>trap color intensity</td>
<td>click the Intensity value to edit it.</td>
</tr>
<tr>
<td>pullback ink (for pull back traps only)</td>
<td>click the pullback ink to change it to another ink.</td>
</tr>
</tbody>
</table>

3. **Click Update Traps 🚀 to apply your changes to your document’s traps.**

**Note:** To change several color pairs the same way, use Command or Shift to select them, then make the changes in one color pair. Clicking Update Traps will apply your changes to all selected color pairs.

### 3.4.4 Trap Sessions

Every time you select Trap... or Trap Selection... in PowerTrapper, the previous sessions of Color Pairs are kept, and a new Session is started.
**Note:** Changing the document will remove previous trap sessions. Only if the document is untouched in between trapping, the different trap sessions will be available.

You can switch to a previous session by selecting the session from the dropdown in the Color Pairs palette.

If you select a trap using the Select Trap tool, the Color Pairs dialog will switch to the corresponding session.

**Note:** The Select Trap tool can only highlight traps from a single session. If you select (by dragging) traps from different sessions, only the traps from the current session are highlighted. If no traps from the current session are selected, the latest created trap session becomes active, and only traps from that session will be highlighted.

**Clear Sessions** in the Fly-out menu removes the Color Pairs information from all sessions, but does not affect the trap layer or the traps, and vice versa: removing the trap layer does not remove the Sessions. Therefore, if you want to restart trapping completely, it’s advised to remove the Trap Layer AND apply “Clear Sessions”.

You can rename a Session by activating it, and clicking **Rename Current Trap Session** in the Fly-out menu.

Trap Sessions are saved when saving the Color Pairs.
Note: To be able to use the option **Respect existing traps**, you have to select the trap as well, otherwise PowerTrapper will assume the document was changed, and the trap sessions will be removed.

### 3.4.5 Saving and Loading Color Pairs

After trapping a document with PowerTrapper Standalone, you can save its color pairs. This ensures you won't need to re-edit the color pairs if you need to change the traps later on.

**When to Save Color Pairs?**

You can save color pairs as soon as you are finished editing them.

If you haven't saved your color pairs, doing the following will discard them:

- closing your document,
- using PowerTrapper Standalone, Viewer or Instant Trapper on another document open in Illustrator.

Note: This doesn't affect your document's traps.

In those cases, PowerTrapper Standalone will ask you if you want to save your color pairs.

**Where are Color Pairs Saved?**

Your color pairs are saved in a file next to your document. This file has the same name as your document and ".tcp" as extension.

Note:

There can be only one color pairs file per document. If you make changes to your color pairs and save them again, your color pairs file will be updated.

If for some reason you need another version of your color pairs file, first save your document under a different name then save the color pairs again.
Saving Color Pairs

- To save your color pairs, select **Save Color Pairs** in the **Color Pairs** palette's fly-out menu.

  **Note:** This is only available when you have unsaved color pairs.

Loading Color Pairs

- To load color pairs that you saved previously, select **Load Color Pairs** in the fly-out menu.

  **Note:**
  
  This is only available if you have saved color pairs for the current document.
  
  You cannot load another document's color pairs.
  
  You cannot load color pairs if you have changed the document after trapping.
4. Selective Trapping

When using the **Trap** button in the **Trap** dialog, trapping is always done on the complete file. To apply traps on a selection only, you can use **Selective Trapping**

Selective trapping can be done by choosing **Window > Esko > PowerTrapper > Trap selection...**

All other options are the same as for normal trapping: see *The Trap Dialog* on page 19

**Note:** The trapping will be calculated only on the selected objects. If an object is not selected, it will not be taken into account when calculating traps, even if the object is on top or behind the selected objects.
5. Add Rich Black

The Rich Black tool can be used to obtain a darker black by overprinting all black areas with the ink that you specify, for example Cyan.

1. Open the Rich Black dialog by choosing **Window > Esko > PowerTrapper > Rich Black**

![Rich Black dialog](image)

2. Select objects using the standard Adobe Illustrator selection tools.
3. Use the **Add** dropdown to select the ink (e.g. C) you want to add to create a rich black. The dropdown will contain all inks present in the job. You can add another ink using **New Separation ...** if needed.
4. Enter the **Density** you want to apply.
5. Set the **Offset** to define the distance between the edge of the added ink and the edge of the black object.
6. Set the **Miter Limit** as you would for trapping. Miter limit determines whether sharp corners in objects appear pointed or beveled. You can also select Bevel and Round options.
   
   **Note:** The Miter Limit option is only available when the Miter option is selected.

7. Use the **To** dropdown to select the colors you want to change into rich black. All areas using the selected color, and above the **Minimal Density** percentage, will become rich black by adding the Add color.
8. Enable **No Other Inks Present** if you only want to create rich black from pure inks, and not in areas that already contain a mix of inks.
9. Click **Create** to generate a layer of overprinting objects to enrich the source ink. The layer will be called "Rich Black" by default.
6. PowerTrapper Preferences

You can open the PowerTrapper Preferences by choosing Illustrator > Preferences > Esko > PowerTrapper Preferences (Mac) or Edit > Preferences > Esko > PowerTrapper Preferences (Windows).

Convert Blended Objects to Images in the PowerTrapper Preferences will convert blended objects to images before trapping. The Resolution for these images can be set to High (600 dpi), Medium (300 dpi) or Low (150 dpi).

If the Use Postscript Compatible Image Traps preference is on, the image trap color option has no influence on the result. Trapping will not generate any extra image data but image traps will create traps with lineart representing vectorized pixels. The lineart will also use Postscript Overprints instead of the multiply blend mode. These image traps are always created using the 'Use Original Data' option. Note that to have a correct visualization of your traps, you need to switch on the 'Overprint Preview' in the Illustrator View menu.

**Note:** The Use Postscript Compatible Image Traps is only applied when using PowerTrapper in Adobe Illustrator. When using PowerTrapper Client, this option is not applied, since it is not compatible with the Trap tasks in Automation Engine 14.

If Keep Links in Image Traps is selected (default), a trap for a linked image will consist of the linked file and a clip mask. This will cause the linked file to be placed (and shown in the Links palette) for every trap. In case of a high number of traps, this might cause stability issues for Adobe Illustrator.

If the option is off, the image for the traps is embedded, and turned into a symbol, which is then used for every trap (with a different clip mask). This will not affect the Links palette, nor will it affect Adobe Illustrator's efficiency. This does not change the original image.
See also Color and Shape Settings on page 24

In the Standalone Trapping Preferences, you can set the location where PowerTrapper Standalone saves the Trap Presets. See Defining a Trap Preset on page 33

• When choosing Use Shared Trap Ticket Folder, Trap Presets are saved in the default “shared users” folder:
  
  • /Users/Shared/EskoArtwork/Trap Tickets on Mac OS X
  
  • C:\Documents And Settings\All Users\Documents\EskoArtwork\Trap Tickets on Windows XP
  
  • C:\Users\Public\Documents\EskoArtwork\Trap Tickets on Windows 7

• When choosing Use Custom Trap Ticket Folder, Trap Presets are saved in the folder you define by clicking the Browse button.

**Note:** Because PowerTrapper in earlier versions (before 10.1) used a different default location, upgrading to 10.1 or higher will try to set the Preference to Use Custom Trap Ticket Folder, pointing to the previous Default folder, so you can keep using your Trap Tickets.